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Abstract 
 
Horvath, P., Barton, D.N., Hauglin, E.A. & Ellefsen, H.W. 2017. Blue-Green Factor (BGF) map-
ping in QGIS. User Guide and Documentation - NINA Report 1445 [s.46] 
 
The blue-green factor (BGF) is a rapid assessment tool to help quantify minimum municipal re-
quirements for surface water management, vegetation qualities and biodiversity in outdoor areas 
of property developments. BGF-QGIS makes it possible to calculate the blue-green factor for 
larger areas than in the original Excel-based methodology, by taking advantage of remote sens-
ing data, GIS datasets, and CAD-based design proposals. It also provides a flexible platform for 
adjusting the scoring of blue-green qualities to suit specific local conditions and priorities. 
 
Peter Horvath, GEco Research Group – Natural History Museum 
David N. Barton, Norwegian Institute for Nature Research (NINA) 
Espen Aukrust Hauglin - Oslo College of Architecture and Design (AHO) 
Halvor Weider Ellefsen, Oslo College of Architecture and Design (AHO) 
 
Contact:  david.barton@nina.no  

mailto:david.barton@nina.no
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Sammendrag 
 
Horvath, P., Barton, D.N., Hauglin, E.A. & Ellefsen, H.W. 2017. Blue-Green Factor (BGF) map-
ping in QGIS. User Guide and Documentation - NINA Report 1445 [s.46] 
 
Blågrønn faktor (BGF) er et verktøy som kvantifiserer krav til uterom når det gjelder vann-
håndtering, vegetasjon og biodiversitet i byggesaksprosjekter. BGF-QGIS gjør det mulig å 
beregne BGF for flere eiendommer og større arealer enn i den opprinnelige Excel-baserte 
metoden, ved å ta i bruk digitale kartleggingsverktøy som integrerer fjernmålingsdata, GIS 
dataset og CAD-basert design. QGIS plattformen gjør det også mulig for enkelt-kommuner å 
tilpasse BGF metoden til lokale forhold ved å endre kriterier og vekter. 
 
Peter Horvath, GEco Research Group – Naturhistorisk Museum 
David N. Barton, Norsk Institutt for Naturforskning (NINA) 
Espen Aukrust Hauglin,  Arkitekthøyskolen i Oslo (AHO) 
Halvor Weider Ellefsen, Arkitekthøyskolen i Oslo (AHO) 
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Foreword 
 
 
The BGF-QGIS application was made possible thanks to the original Blue-green factor method-
ology developed in 20141 by PBE- Oslo Kommune, Bærum Kommune, Dronninga Landskap, 
COWI and C.F. Møller, with the support of the Cities of the Future Project, funded by the Norwe-
gian Ministry of Local Government and Modernisation.    
 
The clear and easily implementable BGF method (2014) using Excel spreadsheets was the basis 
for the later development of an Android app called “BG Calculator”.  The authors of this Docu-
mentation gratefully acknowledge the origins of the methodology and the support from different 
NINA coordinated projects to develop the BGF tool further.  The Android App development was 
supported by the EU FP7 project OpenNESS (2012-2016).  Programming of the BGF-QGIS ap-
plication by Peter Horvath was funded by the ENABLE project, supported by the Biodiversa pro-
gramme at the Norwegian Research Council.  A BGF-QGIS beta version was tested and im-
proved with support of the URBAN EEA project, funded by the Miljøforsk programme of the Nor-
wegian Research Council.   
 
We are grateful to Yuan Wang, University of Helsinki, and students at the Oslo School of Archi-
tecture and Design (AHO) course “By og Arkitektur” Autumn 2017, for testing the BGF-QGIS and 
suggesting improvements.    
      
David N. Barton  
Project coordinator ENABLE Oslo and URBAN EEA 
Oslo, December 2017 
 
 

                                                   
1 Framtidens Byer, Blågrønn faktor. Veileder byggesak. Hoveddelen  28.01.2014. 2014, Plan og bygningsetaten, Bærum 
Kommune, Dronninga Landskap, COWI, C.F. Møller. 
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1 Introduction 
 
 

1.1 What is BGF? 
 
Blue-green factor (BGF) is a tool to assess an urban 
property development’s surface water management and 
vegetation qualities.  It uses classification of blue-green 
areas and additional qualities to calculate a total BGF fac-
tor per property area. It was developed by the Project Fu-
ture Cities (Figure 1) and explained in a 2014 Guidance 
Manual for building permits (Figure 1). 
 

1.2 Approaches to calculating BGF 
 
The 2014 BGF Guidance Manual uses a spreadsheet 
calculator in MS Excel to determine the total blue-green 
factor of a property area.  The user identifies the area for 
blue and green surfaces, and blue and green ‘additional 
qualities’.  The BGF score is calculated as an area-
weighted sum surfaces and additional qualities (Figure 
2). The Excel spreadsheet (Figure 3) required areas to 
be calculated beforehand (i.e. in the field or from a plan-
ning map). In addition, the calculations were limited to 
one property per spreadsheet and no graphical/map out-
put was available. The practical implementation was thus 
limited.  
 
The OSLOpenNESS project developed an Android appli-
cation – BGF calculator2 - to make the BGF accessible to 
a wider public on Smartphones.   The BGF calculator uti-
lized both the calculator and integrated a spatial repre-
sentation of blue-green structures using satellite images 
in Google Maps. The total property BGF could be auto-
matically calculated by mapping the blue-green structures 
within the property using the satellite image. The Android 
BGF Calculator App also had limitations. It was only avail-
able on Android, with minimal customization. Surface ar-
eas could be digitised using a stylus on a pad, but was 
inaccurate when using ones fingertip.  The App could not 
utilize property cadastre boundaries to delineate individ-
ual properties. Furthermore, the App only stored BGF pro-
jects on the Smartphone’s internal memory with no import 
or export functions to a database.  The BGF Calculator 
App only contains a simple export function of a csv file of 
the data via e-mail. 

                                                   
2 The BGF Calculator App for Android is available here: https://play.google.com/store/apps/de-
tails?id=no.nina.bgf_app&hl=en 

 
Figure 1. Blue-green factor Guidance 
Manual for building permits, developed by 
the Future Cities Project. Source: Framti-
dens Byer, Blågrønn faktor. Veileder byggesak. 
Hoveddelen  28.01.2014. 2014, Plan og byg-
ningsetaten, Bærum Kommune, Dronninga 
Landskap, COWI, C.F. Møller. 

 
Figure 2. The blue-green factor is an area 
weighted sum of blue-green surfaces and 
additional qualities  

https://play.google.com/store/apps/details?id=no.nina.bgf_app&hl=en
https://play.google.com/store/apps/details?id=no.nina.bgf_app&hl=en
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MOTIVATION: 

 

 
Figure 3. Facimile of the MS Excel calculator in the original BGF methodology (Fremtidens Byer 

2014) (original in Norwegian) 
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The above mentioned limitations led to development of an integrated scheme interface in QGIS 
to calculate BGF. QGIS is an open-source Geographic Information Software (GIS) for viewing, 
editing, and analysis of geospatial data. 
 
The motivation was to improve and include the following processes:  

• Ability to use BGF process directly in the field (in addition to office use) 
• Utilize multiple ortho-photos and/or satellite images (e.g. to switch between summer and 

winter images – to map both the canopy and understorey vegetation)  
• Use additional GIS land cover layers to support further appraisals such as  ecosystem ser-

vices  
• Use additional spatial structures (such as property boundaries) and data (e.g. for snapping 

or as aggregation units…) to aid the mapping process.  
• Possibility to adjust weighting of BG structures in the future 
• Producing map outputs of different property areas or scenarios 
• Customizing interface  

By using the Free and Open Source Software QGIS, one can accomplish all of these goals within 
a highly customizable and user-friendly interface. 
 

1.3 Using BGF-QGIS in urban planning 
 
The original BGF methodology was intended as a tool to support the integration of blue and 
green structures in building and landscape architectural design at property level.   It opened up 
the possibility of municipalities providing recommendations or requirements for a minimum BGF 
scores that should be achieved within the delimited area of single properties. BGF guidance 
(2014) proposed that minimum BGF scores be differentiated according to the density of inner 
and outer city areas.   
 
However, the evaluation of minimum requirements for BGF scores at the level of neighbour-
hoods, encompassing several properties with different forms of program, ownership and land-
scape characteristics was not easy to evaluate using the original BGF methodology.   By enabling 
BGF in a QGIS platform, it is possible to cost-effectively map existing blue-green structures by 
means of integrating remote sensing data, GIS datasets, and CAD-based design proposals.   
 
BGF-QGIS thus makes it possible to evaluate alternative planning and design scenarios using 
BGF methods for larger areas.  This should make the BGF mapping and valuation methodology 
an assessment tool that is useful also in planning and urban development processes.  Further-
more, the BGF-QGIS methodology applied within urban planning and development provides an 
efficient quantitative measurement tool.  It makes quantification of blue-green surfaces and qual-
ities equally available as other forms of quantitative planning and design data.   BGF in a QGIS 
platform not only enables data collection in larger areas than before, but also accentuates and 
visualizes environmental amenities that have often been undervalued in urban planning pro-
cesses.  
 
One size does not fit all. In this QGIS application, users can adapt the BGF methodology to 
include new blue-green structures, as well as change the relative importance of each structure 
in the total BGF score. This makes it easier to adapt the methodology to particular needs and 
conditions of different municipalities.   
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1.4 BGF method modifications implemented in BGF-QGIS 
 
During the development of BGF Calculator App we recognised that ‘trees’ in the original BGF 
method required an adaptation for stands of trees where it is impractical to count individual trees.  
We implemented an option where tree crown cover could be mapped, while keeping the original 
option of entering the individual number of trees on a property. In the original BGF methodology, 
individual trees are assumed to have standard canopy area depending on their height classifica-
tion. BGF users had to have knowledge of tree height in order to implement this function. 
 
In BGF-QGIS we have simplified the idea of tree canopy mapping further.  The user now maps 
the tree canopy area of individual trees, as well tree stands, in the same way, by digitising canopy 
cover.  While tracing canopy sizes for individual trees is moderately more time consuming than 
entering a number for different tree sizes on the property, canopy mapping provides an accurate 
estimate of tree canopy. This mapping can be validated against ortho-photos. Considering the 
structural importance of trees for ecosystem functions this is a feature that responds to the pur-
pose of the original BGF methodology, as well meeting future needs for detailed mapping of 
urban ecosystem qualities. 
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2 Set up and getting started 
 

2.1 Get the basic overview of GIS 
 
Before beginning with BGF-QGIS, it is highly recommended to get briefly familiarized with the 
basic knowledge about GIS, for example by going through the following easy step-by-step intro-
duction tutorials:  

• GIS systems (http://docs.qgis.org/2.14/en/docs/gentle_gis_introduction/index.html)  
• QGIS software and interface (http://docs.qgis.org/2.14/en/docs/training_manual/in-

dex.html)  

 
2.2 Required QGIS version & plugins  

 
This project was built under version of QGIS 2.18.11 'Las Palmas' that was released on 
21.07.2017. It is recommended to use the latest available version of QGIS software (but NOT 
older than mentioned above).  
 
To obtain your version of QGIS, follow the link below: 
https://www.qgis.org/en/site/forusers/download 

 
 

2.3 Installation Workflow 
 
Please follow this workflow in order to avoid structural problems within BGF-QGIS 

1) Install QGIS 
2) Install required plugins  
3) Download folder structure from GitHub 
3) Open project and start Mapping 
 

 
2.4 Required Plugins  

 
In order for the BGF-QGIS project to work correctly, you need to have specific plugins installed 
in QGIS. Please install all plugins BEFORE opening the BGF project in QGIS. 
 

o Form value relation 
 Form value relation plugin implements of complex dynamic filters 

and makes available multi-level relations and dependencies be-
tween the drop-down items in the fill-in forms. 

 https://www.itopen.it/a-new-qgis-plugin-allows-dynamic-filtering-of-
values-in-forms/ 
 

o refFunctions 
 refFunctions utilizes a more flexible Field calculator functions in 

QGIS and allows to control behaviour between different layers 
 https://geogear.wordpress.com/2014/11/13/reffunctions-v1-0/ 

 

All the required project files that will be used in this tutorial are available for download at 
GitHub https://github.com/peterhor/BGF-QGIS 
 

https://www.qgis.org/en/site/forusers/download
https://www.itopen.it/a-new-qgis-plugin-allows-dynamic-filtering-of-values-in-forms/
https://www.itopen.it/a-new-qgis-plugin-allows-dynamic-filtering-of-values-in-forms/
https://geogear.wordpress.com/2014/11/13/reffunctions-v1-0/
https://github.com/peterhor/BGF-QGIS
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2.5 Optional Plugins  
 

o QGIS Cloud Plugin  
 Qgis Cloud Plugin is a powerful Web-GIS platform for publishing 

maps, data and services on the internet. 
 http://qgiscloud.com/ 

o Other options for publishing include qgis2web, QGISQUICK, Lizmap 

 
2.6 Installing Plugins  

 
Installing plugins is available through the following menu: 
Plugin -> Manage and Install Plugins… -> 

Choose the abovementioned plugins and hit “install plugin” . 
 

 
 
Continue by installing all three required plugins: “Form value relation”, “refFunctions”, and “Qgis 
Cloud Plugin”.  
 
IMPORTANT! Open BGF-QGIS project only after all three plugins are installed.   If not the added 
functionality will not be available in the project. 
 

2.7 Opening a BGF-QGIS project 
 
You can open the QGIS project file “BGF_qgis_project.qgs” directly from your file browser. Al-
ternatively you can navigate to the project file “BGF_qgis_project.qgs” through an already 
opened instance of QGIS:  
 
Project -> Open (Ctrl+O) 

http://qgiscloud.com/
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The project is now directly prepared for you to start mapping (skip to section 4 Digitizing BGF 
Structures). However, if you want to customize or add additional Web Map Services or Ras-
ter/Vector layers, start by following the sections below: 3.1 How to add WMS and 3.2 Adding 
raster / vector files from disk.  
A backup copy (preferably zipped) should be kept in case you need to recover your project or 
start over.  
 

2.8 Adding additional background data 
 
A Web Map Service (WMS) is a standard protocol for serving georeferenced map (over the In-
ternet) images which a map server generates using data from a GIS database.  
 
Since it is streamed over internet, it does not take up space in your final project, such as ras-
ter/vector data would. However, the disadvantage it has over raster/vector files stored locally is 
that its structures are not editable/trackable within the project other than visually. Also you have 
to be ONLINE and with a good internet connection for accessing WMS.  Otherwise rendering 
WMS can be slow and make mapping less efficient.  This can be an obstacle in the field.  
 
This is an OPTIONAL step for those who want to have additional maps form the WMS. You can 
add WMS layer from different servers by using their URL link. Do this by following: 
 

1. Layer -> Add Layer -> Add WMS/WTMS Layer 

 
 
 

2. Add NEW service  
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3. Type in link to a desired WMS server and name it accordingly. In our case type the 
following link to ”FKB” WMS server. 

http://wms.geonorge.no/skwms1/wms.fkb3?service=WMS&request=GetCapabilities  
 

 
 

4. Click “connect” 
 

5. Choose desired layers to be displayed in QGIS: 
 

E.g.  ID 134 for vector layers (example “Eiendomskart” ) – IMPORTANT: Choose 
PNG encoding 
 

 
 
 
 
 

 

http://wms.geonorge.no/skwms1/wms.fkb3?request=GetCapabilities&service=WMS
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6. You can also add some other useful and freely available WMS services. These in-
clude the Norwegian Common Geo-Database “FKB”, where you find layers about 
data:  

a. AR5 – land use 
b. Contour lines 
c. Water bodies 
d. Transport network 
e. Buildings 
f. Properties 
g. Object/city names and labels 

http://wms.geonorge.no/skwms1/wms.fkb3?service=WMS&request=GetCapabilities  
Please note: This data is freely available and the publisher GeoNorge reserves against 
the accuracy of the data - data could be outdated. Also note that some of these WMS 
layers are only visible at a certain extent (i.e. You have to zoom in/out in order for the 
map to be shown) 
 

7. Alternatively, if you are a subscriber of “Norge-Digitalt lisens”, you can access the 
most accurate and up-to-date “Matrikkelen” WMS services of all Norwegian munici-
palities through GEONORGE.no webportal. 

http://wms.geonorge.no/skwms1/wms.matrikkel.v1? 
 

The satellite/aerial images are usually labelled with a year they were taken. It is a good 
practice to use a couple of images, preferably from different seasons of the year. This 
way you can see both the ground cover (on an autumn/winter image without leaves) and 
the canopy cover (on a spring/summer image). 
 

8. For other FREE raster base-maps install Plugin “OpenLayers Plugin” (following in-
structions from 2.2 Required Plugins). After installing, make sure to add desired 
layers 

 
 
Another alternative of FREE raster base-maps is a plugin called “QuickMapServices”.  
 
 
 
 
 
 
 
 
 

 

http://wms.geonorge.no/skwms1/wms.fkb3?request=GetCapabilities&service=WMS
http://wms.geonorge.no/skwms1/wms.matrikkel.v1
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2.9 Adding raster / vector files from disk 
 
If you want to use some other raster / vector files from your computer, follow this path: 

1. Layer -> Add Layer -> Add Raster Layer / Add Vector Layer 

 
 

2. Navigate to desired files. Most commonly used vector files are marked with file exten-
sion “shp”, or shapefile. Raster files need to be georeferenced and the common file for-
mat is geoTIFF or “tiff”. 
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3 Mapping BGF Structures 
 
The main part of this tutorial is about digitizing  urban structures and determining their total BGF. 
The tutorial is divided into three parts in which you first outline your desired locality (for example: 
parcel bounded by property borders – in our case municipality directorate). Then you begin with 
mapping/describing each particular Blue-green Structure for this locality and finish by adding 
Additional Qualities. In this tutorial we will map the Governor’s property in Ås.  
 

3.1 Locality level 
 
This is where you delineate your locality. During this first part we will be working only within layer 
“BGF_locality_area”. Thus, start by selecting layer “BGF_locality_area” in the Layers Panel  
View -> Panels -> Layers Panel 

1. Activate editing for the layer “BGF_locality_area”, by clicking on the “Toggle Editing” 
pencil. 
 

 
 
 

2. Click “Add feature” to add new polygon 
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3. Begin digitizing 
 

a. Turn on ADVANCED DIGITISING TOOLBAR by right-clicking anywhere on the 
panels 

 

 
 
b. Use “Enable tracing” button to easily follow property boundaries of layer 

“0214_Eiendom teiggrense (Linje)” 

 
 

c. Begin by drawing polygon around the estate boundary clicking in each corner / 
all arcs of the polygon. Make sure your internet connection is working and that 
the map image is updated before continuing to digitise nodes of the polygon. 
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d. Finish by right clicking inside created polygon. Fill in required information about 
ID and Locality_number (allowed values integer from 1 to 10) 

 
 
e. Optionally fill in overview photo of the locality (or fill it later with the “Identify 

Features”, see below).  
 

f. Press “OK” 

 
g. If you do not want to save the polygon select "cancel". 

 
 

4. To see properties for a polygon use “Identify Features” button .  
 

a. If editing mode is turned on, you can also edit the properties through 
“Identify Features” button.  
 

b. Make sure to have “Auto open form” in the “Identify Results” enabled 
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5. To change corners/nodes, press “Node Tool”  
 

a. To add new nodes - double-click between two existing nodes where want the 
new node to be created. 
 

b. To move nodes, mark the node (becomes blue square), then drag to the new 
position 

 
c. To remove points, mark the node (becomes blue square), then press "Back-

space" on the keyboard. 

6. To split a polygon into two use button "Split Features" .   Draw a split by cutting the 
polygon on both sides, then right-click. 

 
7. To merge polygons 

 
a.  you first have to select the polygons to be merged by using “Select Features” 

 (selected polygons are in yellow) 

b. join polygons with “Merge Selected Features” button  
 

c. Select which of the merged polygon’s properties you want to maintain in the 
pop-up window (the properties that are retained appear in the row called 
"merge"). 

8. Use button “Save Layer edits” often  
 

9.  When done digitizing exit editing mode by clicking on “Toggle Editing” pencil.  

 
 

10. Save the whole project by clicking on “Save” button 
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So far, there is a maximum limit of 10 localities within one open BGF-QGIS Project. If you need 
to map more localities, then you have to open another separate instance of QGIS 
 

3.2 Other features  
 

1. To zoom in / out, or move to a new location on the screen, use one of the buttons here: 

 
 

2. Select polygon with . By drawing a square around polygons, all within the 
square is selected. Other ways of selecting polygons can be found by pressing on the 
black arrow. 

3. Remove selection of selected polygons with  
 

4. Delete a selected polygon by pressing  
 

5. Measure distance by  button. Choose "target line" on the black arrow if it does  
not come automatically). 
 

6. Measure area by  (choose "target area") 

3.3 Snapping Options 
 

1. Adjust snapping options (Settings -> Snapping Options) for the different stages of 
mapping process according to your needs (recommended value 10 pixel units).  

 
 

2. It is also recommended to keep “avoid intersections” enabled for the first stage 
of mapping (BGF1 - Blue-Green Surfaces), as here we will have to cover the 
whole locality area without gap and overlap.  
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This way, when mapping a lawn around an already created building polygon, this will be 
clipped away automatically. 
 

   
 
 
3. For the second stage of mapping (BGF2 - Additional Qualities) you must have “avoid 

intersections” disabled. This is important to be able to place/map additional qualities on 
top of Blue-Green Surfaces (enable overlaps).  

 
3.4 BGF1 – Blue-Green Surfaces  

 
The main part of the project is to map Blue-Green Structures within a locality. You do that by 
assigning BG factor attributes to each mapped polygon.   The mapping is divided into two stages 
BGF1 mapping surfaces and BGF2 mapping additional qualities. 
 

1. Digitizing BGF inside LOCALITY 1 
a. Select layer “BGF_flate” 
b. Repeat steps 1 (turn on edits) and 2 (add new polygon) as in section 4.1 Locality 

level  
 

2. Start with digitizing large structures in the Blue-Green Surfaces - BGF1 level (see sec-
tion 4.6 STRUCTURE below.) 

a.  You can use the raster layer “Bygning_polygon” to help you with digitizing build-
ing structures 
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3. Choose option “Blue-Green Surfaces” after finishing drawing a polygon 

 
 
 

4. Based on your choice, new menus will become available.  

 
 

5. According to the structure, choose one of the 9 available Blue-Green Surface types. 
Use description to know more about the BG surface type. To confirm polygon creation 
click on “OK”. 
 

6. Polygon with a label will show up on your map 
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7. Inspect created polygon for mistakes and topology errors (green cross instead of a red 

node) 
a. Topology errors should be avoided at all costs. To learn about what happens 

when you have topology errors see section 4.7 Topology checker. 

 
 

8. Adjust vertices in case necessary  

 
 

9. Save edits to the “BGF_flate” layer often. This helps you not losing your data and to up-
date information in the attribute table. 

 
 

 
10. It is important to map the whole area of each locality using one of the Blue-Green Sur-

faces before you start adding Additional Qualities. This is because the blue-green fac-
tor is standardised by the total property area.  If some surfaces are left out it will bias 
the overall BGF downward 
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11. In order to reuse the attributes from the previously mapped polygon, go to  

Settings -> Options -> Digitizing -> “Reuse last entered attribute values” 

 
 
 

 
 

12. Optionally you can check the progress of you mapping by hitting the “Show Statistical 
Summary” button on the Attributes toolbar (and choosing the correct layer i.e. 
“BGF_flate” to display summary for) 
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3.5 BGF2 - Additional Qualities.  
 
Additional qualities are mapped on top of Blue-Green Structures, and thus can overlap.  If you 
have enabled “avoid intersections” (step 3. in section 4.2 you have to turn it back OFF for layer 
“BGF flate”.  
 
For better visual inspection of the aerial image for Additional qualities, you might want to turn off 
“visibility” of some of the already mapped polygons from BGF1 level. You do this in the Layers 
Panel. 

 
 

1.  In the dropdown menu for mapping level, choose Additional Qualities (see section 4.8 
STRUCTURE below.) 

 
 

2. Select corresponding group of additional qualities from four available options 
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3. Finally, when all desired information is filled based on your choice. Click on “OK” to cre-
ate polygon. 

 
 
4. At the end, you should end up by digitizing all Additional Qualities of a locality.  

 
 

 
 

 
5. In many cases already mapped surfaces will also take on qualities in the same poly-

gon, f.ex. green space > 75m2. To copy an existing polygon from BGF1 - Blue-Green 
Surfaces, and assigning it an BGF2 – Additional quality value, first select the chosen 
polygon with “Select” button. Then click “Copy” button (or Ctrl+C) and subsequently 
“Paste” button (or Ctrl+V). The polygon is now be copied over the original one (Note: 
“Avoid intersections” in snapping options have to be unclicked).  

 
 

Now press “Identify Features” button to adjust attributes for the newly created polygon.  
 

6. IMPORTANT: If, after you have created a polygon, it does not have a label or is col-
oured with red “NOT MAPPED PROPERLY”, you have to check and correct it. Python-
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init function in QGIS forms should also warn you about such cases before they are en-
tered. 

 
 

 
The reason is that not all the required fields have been filled and thus the BGF cannot 
be calculated. Make sure to fill attributes before clicking OK. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Future improvements:  
BGF1 and BGF2 will be available as two separate layers, which 
will simplify the attribute table and make the form value relation 
unnecessary. We plan on using Spatialite or GeoPackage and 
then having spatial views for aggregating data into the locality 
level. 
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3.6 Structure overview 
 
The following lists the blue-green structures implemented in the BGF methodology.    
 

BGF1 Blue-Green Surfaces 
A. Blue-Green Surfaces 

A1. Open permanent water surface that can receive rainwater 
A2. Partially permeable surface like gravel, crushed stone, and reinforced grass sur-

face 
A3. Impermeable surfaces with drainage to vegetated areas or an open drainage 

magazine 
A4. Impermeable surfaces with drainage to a local closed storm water drainage 
A5. Surfaces with vegetation associated with soil or bedrock 
A6. Surfaces with vegetation, not associated with soil > 80 cm 
A7. Surfaces with vegetation, not associated with soil 40 - 80 cm 
A8. Surfaces with vegetation, not associated with soil 20 - 40 cm 
A9. Surfaces with vegetation, not associated with soil 5 -20 cm 

 
BGF2 Additional qualities 

B. Blue additional qualities 
B1. Natural edges to water surfaces 
B2. Rain bed or equivalent 

C. Green additional qualities - tree canopy  
D. Green additional qualities - other  

D1. Native vegetation 
D2. Hedges, bushes and multi-stemmed trees 
D3. Green walls 
D4. Perennials and other ground cover 
D5. Contiguous green areas over 75 m2 

E. Connectivity of structures (filled in with the number 0,05) 
E1. Connectivity to an existing Blue-green structure. 

 

3.7 Topology checker 
 
It is important that the topology in the map be correct! Errors often appear with a green cross: 

 

 

Or when you see such orange warning about GEOMETRY ERRORS. 

 

Failure in topology causes problems with snapping, and should be corrected as soon as they 
occur. 

Errors can often be corrected by moving or deleting additional (green) nodes 
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1) You can check for errors in topology by navigating into  
a. Vector -> "Topology checker"  

2) Add topology rules by pressing . Using the rules you set a verification procedure 
checks already created polygons for errors. The rules must be added for the layer 
"BGF_flate".  

 

a. Useful rules are "must not have invalid geometries"  
b. and "must not have gaps". 

3) Check if the topology of your map is correct by pressing .  
 

4) BGF for polygons with invalid geometries will still be calculated. However, it will not be 
possible to further snap towards this incorrectly created polygon.  
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4 Browsing through registered data 
 
Throughout the mapping/digitizing process, you can check the registered data in attribute table.  

 
 

For example it is useful to check for the polygon area, polygon BGF or the final BGF for the 
whole locality. Otherwise, you find all the data about BGF type codes, descriptions, labels or 
percentage of mapped area.  

You can go back and change some of the attributes by using “Identify Features” button . 

To check statistical summary of registered data use  button (for more info, see 10.4 - How 
to calculate simple statistics for total BGF score) 
 
The following fields are being registered while you digitize BGF into polygons. Each of the fields 
has its function in final calculation of BGF. (see section APPPENDIX for more details about code 
used.) 

Attribute name Attribute Description 

Id ID number 
1_BG_surf Blue-Green Surface 
1_BG_val Blue-Green Surface Value 
2_BG Group of Additional Qualities 
2_BG_type Additional Quality type 
2_BG_val Additional Quality Value 
0_BG_level BGF level 
1_BG_descr Blue-Green Surface – Description 
2_BG_descr Additional Qualities – Description 
Photo link to picutre of polygon 
2_BG_label Additional Qualities – Label 
1_BG_label Blue-Green Surface – Label 
1_BG_lab_c Blue-Green Surface - Label shortcut 
2_BG_lab_c Additional Qualities - Label shortcut 
BGF_locality_area_loc_area Locality area  
Area Polygon total area (in m^2) 
BGF1 BGF for Blue-Green Surface polygons 
BGF2 BGF for Additional Qualitiy polygons 
BGF_Code BGF code  
Loc_num Locality number  
tot_BGF1 Total BGF1 - surfaces for each locality 
tot_BGF2 Total BGF2  - additional qualities for each locality 
MappedArea fraction of mapped area/total area 
E1_connect Connectivity found? (Y/N) 
BGF_final Final BGF score for each locality 
BGF_contrb Per-cent contribution of a given polygon to the total locality BGF 
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5 Final BGF score 
 
The most important part of the whole mapping and digitizing is a final score for Blue-Green Factor 
for each locality. This value is displayed in the last column of attribute table “BGF_final”. The 
value is specific for each locality, but same for each mapped polygon within a locality.  
 

 
 
The field “BGF_contrb” registers the per-cent contribution of a given polygon to the final BGF 
factor.  
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6 Export of registered data 
 
Right click on the layer that you want to export and choose “Save as”. Choose “Comma sepa-
rated value [CSV]” format  
 

 
 

 
 

Your project database is now saved as CSV file, which you can open statistical software and MS 
Excel). The statistical package “R” can read dbase files directly.  
 
IMPORTANT: If you are to share your whole project (not only output), it is important to attach all 
necessary files. This means not just the “project.qgs” file, but all vector, raster and table data. 



NINA Report 1445 
 

35 

The easiest way is to Use QConsolidate (if you did not use server-databases that may become 
inaccessible).  
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7 Sending your data to CLOUD  
 
If you have installed the optional plug-in QGIS Cloud Plugin during step 2.5 Optional Plugins, 
you only need to create a free account to share your data with other QGIS users. You do this by 
following instructions on the sign up page of QGIS Cloud  
(https://qgiscloud.com/en/account/sign_up).  
 
Now you have to enable the QGIS Cloud Plugin through  
View -> Panels ->QGIS Cloud.  

After creating an account you sign in using your credentials into QGIS Cloud Plugin through 
QGIS 

 
 
By sending your data to the QGIS cloud you can share it with your colleagues or make it avail-
able to the public.  

 
When uploading your data to the QGIS Cloud, keep in mind which of your layers might have 
restrictions on being publicly shared (ex: some raster layers or property data). 
 

https://qgiscloud.com/en/account/sign_up
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8 Communicating your results 
 

8.1 Map output (Print Composer) 
 
Usually, the process does not end by mapping an area for BGF. Some sort of output is required. 
You can present your data in several ways. For example by producing a Map Layout in “Print 
Composer”. Learn more about how to create layouts in the QGIS Tutorials: 
https://docs.qgis.org/2.0/en/docs/user_manual/print_composer/print_composer.html 
Example output Map of the Ås Municipality area: 

 
 
Many other customization options exist in QGIS. You can change the colour scheme or labels 
and tweak your final map layout into perfection. (see hints and tutorials below)  
 
http://docs.qgis.org/2.0/ca/docs/training_manual/basic_map/symbology.html 
 
http://docs.qgis.org/2.0/ca/docs/training_manual/vector_classification/label_tool.html 
 
https://gis.stackexchange.com/questions/3083/what-makes-a-map-beautiful 
 
 
 
 
 
 
 
 
 
 

https://docs.qgis.org/2.0/en/docs/user_manual/print_composer/print_composer.html
http://docs.qgis.org/2.0/ca/docs/training_manual/basic_map/symbology.html
http://docs.qgis.org/2.0/ca/docs/training_manual/vector_classification/label_tool.html
https://gis.stackexchange.com/questions/3083/what-makes-a-map-beautiful
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8.2 Data output (Excel, R, Matlab …) 

 
You can also export you final data into a CSV table (as shown in section 7 Export of registered 
data) and analyse them with your favourite statistical program.  (Advanced users can also do 
analyses without data export within QGIS, e.g. using R script in Processing or statistical sum-
mary plugin.) 
 
Here we produce summary diagrams in Excel. Some examples are provided below, but de-
pends only on your imagination/needs. NOTE: you will have to do some data clean-up before 
analysis.  

 
 

8.3 Highlighting selected features of your project – focusing your 
message 

 
In some cases you may wish to highlight some blue or green features in the map of your locality. 
For example, it could be that a selection of trees on the property will be cut, perhaps to be com-
pensated with the same or larger tree canopy elsewhere with newly planted trees. You wish to 
highlight these qualities in a separate map, and calculate the BGF score only for this subset of 
qualities (in order to illustrate the amount of BGF that needs to be compensated). 
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First, select the features you wish to highlight (e.g. individual trees) by identifying on the map, or 
by their attributes. 
 

1. To extract attributes of the selected features with selected fields for calculation 
 

a. You can select features either by attributes 

 
 

b. Or select manually 
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2. Save selected features as CSV, see section “7 Export of registered data” in this 
manual. Additionally tick “Save only selected features” and unselect the fields you 
don’t need in the list of “Select fields to export”: 

 
 

3. Alternatively you can create a new layer from selected features  
a. Select the features you wish to highlight 
b. Right click the “BGF_flate” layer -> Save as: 

 
 

c. Choose ESRI Shapefile as Format.  Other formats can be found at  http://switch-
fromshapefile.org/ 

d. Click Browse for File Name, where you name this new layer with selected fea-
tures, e.g. “trees”, and choose where you want to store the new vector layer 

e. Tick save only selected features. 

By doing this, you create a GIS shapefile stored as several specific files. 
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Now you have a subset of the “BGF_flate” with only the selected features, where you can either 
extract attribute table or define how you highlight them. More instructions for setting symbology 
see section 9.1 Map output (Print Composer).  
 
An example of the outcome of highlighting selected features in 2 ways with Ås Municipality area:  
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9 Adjusting advanced settings in BGF-QGIS project 
 
It is possible to make changes to the internal “core” information for BGF-QGIS system.   In par-
ticular criteria can be added/removed/edited and the weighting can be changed.   All this core 
information is stored in CSV files inside folder “CSV”.  
 

9.1 How to restore default layer style again 
 
If any unwanted changes have happened in BGF_flate layer (for example colors, labels or cal-
culations have changed), you can load a layer style from a previously saved file. Do this by 
navigating into  “BGF_flate” layer (in layers panel) - > layer properties -> Style (button in the 
lower left corner) -> load Style.  Now navigate to style file in our project folder and subsequently 
subfolder “BGF_final_clear” -> “STYLE” -> “bgf_final_10.qml” 
 

9.2 How to add, remove, edit description of BGF-QGIS criteria. 
 
All values and names are stored in file folder named “CSV” in the files “0_EN.csv”, 
“1_EN_bluegreen_areas.csv”, “2_EN.csv” and “BGF_EN.csv”. In case you decide to adjust 
some of the information (description, new parameters), this can be done through changing one 
of the abovementioned files. Notice that the QGIS project needs to be closed (and saved) at this 
point. 
 

9.3 How to change weighing of BGF 
 
In case you decide to adjust weighing system of BG surfaces, this can be done through changing 
file named “BGF_EN.csv” in file folder CSV. Notice that the QGIS project needs to be closed 
(and saved) at this point. After opening the file “BGF_EN.csv”, change appropriate weights in 
column “value” for given Blue-Green Surface or Additional Quality.  
 

9.4 How to calculate simple statistics for total BGF score  
 
Choose 
View -> Panels -> Statistics Panel.  

    
 
OPTIONAL: To display a histogram of values for a desired field in addition to basic statistics, you 
can use plugin “Statist” (which you install using same procedure as mentioned during step 2.2 
Required Plugins).  
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9.5 File structure in the MAIN folder 
 
MAIN folder is named “BGF_final” and inside you find the following sub-
structure 

• CSV – contains all spreadsheet tables with data 
• DOCUMENTATION – tutorial for use of the BGF-QGIS project 
• STYLE – QGIS style file for “BGF_flate” layer containing field struc-

ture, label and colour coding 
• VECTOR – all vector files used in the project (ex: BGF_flate, 

BGF_locality_area, property borders) 
• BGF_qgis_project.qgs – project file to be OPENED 

 
 
 
 
 
 
 

Future improvements:  
We plan on using Spatialite DB instead of the current filesystem. 
This way all data (except documentation) can be stored in SQL 
format. This will allow also spatial views for aggregation and 
make some of the plugins unnecessary.  



NINA Report 1445 
 

44 

10 References 
 
Framtidens Byer (2014) Blågrønn faktor. Veileder byggesak. Hoveddelen  
28.01.2014. 2014, Plan og bygningsetaten, Bærum Kommune, Dronninga Land-
skap, COWI, C.F. Møller. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



NINA Report 1445 
 

45 

 

11 APPPENDIX 
 
11.1 Abbreviations, description and diagram for BGF structures in 

BGF-QGIS 
 

Code Short label Description Value Picture 

A1 OPW Open permanent water surface that can receive rain-
water 1 

 

A2 PP Partially permeable serface like gravel, crushed stone, 
and reinforced grass surface 0.3 

 

A3 IOD Impermeable surfaces with drainage to vegetated ar-
eas or an open drainage magazine 0.2 

 

A4 ICD Impermeable surfaces with drainage to a local closed 
storm water drainage 0.1 

 

A5 DGW Surfaces with vegetation associated with soil or bed-
rock 1 

 

A6 VS80 Surfaces with vegetation, not associated with soil > 80 
cm 0.8 

 

A7 VS40-80 Surfaces with vegetation, not associated with soil 40 - 
80 cm 0.6 

 

A8 VS20-40 Surfaces with vegetation, not associated with soil 20 - 
40 cm 0.4 

 

A9 VS5-20 Surfaces with vegetation, not associated with soil 5 -
20 cm 0.2 

 

B1 NWE Natural edges to water surfaces 0.3 
 

B2 RB Rain bed or equivalent 0.3 
 

C1 CCT Tree canopy (% of total 
area)  

D1 NV Native vegetation 0.6 
 

D2 HB Hedges, bushes and multi-stemmed trees 0.4 
 

D3 GW Green walls 0.4 
 

D4 PP Perennials and other ground cover 0.3 
 

D5 GA Contiguous green areas over 75 m2 0.1 
 

E1 C Connection to an existing Blue-green structure. 0.05 
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11.2 Code used in calculations of virtual fields: 
 
#### BGF1 
$area * "1_BG_val" 
 
#### BGF2 
CASE 
  when  "2_BG_type" =  'C1'  
 then   ($area  / "BGF_locality_area_loc_area" ) * 100 
 when   "2_BG_type" =  'C2'  
 then   ($area  / "BGF_locality_area_loc_area" ) * 100 
    else  $area *  "2_BG_val"  
 
END 
#### BGF_CODE1 
 concat(  
 left(  "1_BG_surf" , 1) ,   
 left( "2_BG_type" , 1) 
 ) 
 
#### LOC 
geomintersects( 'BGF_locality_area',  'loc_number') 
 
#### tot_BGF1 
CASE 
 when "loc_num" = 1 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=1 ) 
 when "loc_num" = 2 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=2 ) 
 when "loc_num" = 3 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=3 ) 
 when "loc_num" = 4 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=4 ) 
 when "loc_num" = 5 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=5 ) 
 when "loc_num" = 6 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=6 ) 
 when "loc_num" = 7 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=7 ) 
 when "loc_num" = 8 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=8 ) 
 when "loc_num" = 9 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=9 ) 
 when "loc_num" = 10 
 then aggregate( 'BGF_flate', 'sum', "BGF1",filter:="loc_num"=10 ) 
 else NULL 
END 
 
#### tot_BGF2 
CASE 
 when "loc_num" = 1 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=1 ) 
 when "loc_num" = 2 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=2 ) 
 when "loc_num" = 3 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=3 ) 
 when "loc_num" = 4 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=4 ) 
 when "loc_num" = 5 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=5 ) 
 when "loc_num" = 6 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=6 ) 
 when "loc_num" = 7 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=7 ) 
 when "loc_num" = 8  
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=8 ) 
 when "loc_num" = 9 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=9 ) 
 when "loc_num" = 10 
 then aggregate( 'BGF_flate', 'sum', "BGF2",filter:="loc_num"=10 ) 
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 else NULL 
END 
 
#### mapped area 
 CASE 
 when "loc_num" = 1 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=1 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 2 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=2 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 3 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=3 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 4 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=4 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 5 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=5 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 6 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=6 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 7 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=7 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 8 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=8 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 9 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=9 ) / "BGF_locality_area_loc_area"
 when "loc_num" = 10 
 then aggregate( 'BGF_flate', 'sum', "area", filter:="loc_num"=10 ) / "BGF_locality_area_loc_area"
  
 else NULL 
END 
 
#### E1 
case  
 when "2_BG_type" = 'E1' then 0.05 
 else NULL 
  
end 
 
#### BGF_final 
case 
 when "Loc_num" = 1 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 1) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 2 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 2) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 3 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 3) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 4 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 4) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 5 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 5) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 6 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 6) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 7 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 7) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 8 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 8) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 9 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 9) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area" when "Loc_num" = 10 
 then  if(aggregate('BGF_flate' , 'count_distinct', "E1", filter:= "Loc_num" = 10) = 1, 0.05, null)+
 ("tot_BGF1"+ "tot_BGF2") / "BGF_locality_area_loc_area"  
END  
 
#### BGF_contrb 
 
if ( "BGF1" is not NULL,   
 ("BGF1" / ("tot_BGF1" +  "tot_BGF2" )) * 100,  
 ("BGF2" / ("tot_BGF1" +  "tot_BGF2" )) * 100) 
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